
number 1.  Each time you start a new column, PGGP will ask you which type of 
behavior entry you plan to use.  If you only plan to use choice #1 exclusively, there is a 
"Stop Asking" check box.  If you plan to use Choice #2,  you will have to put up with the 
choice box. 

To Set Behavior Definitions, go to the Settings Menu and choose Behavior 
Definitions.  You can enter some generic behavior problems for both Classroom and 
Playground.  More is explained in the Settings Section later in this booklet.

The module was intended to be used daily to record student behavior problems.  
There are other ways to use the behavior module.

Daily use:  To select a student, click on the cell for the date you wish to record an 
indiscretion.  If there are no dates PGGP will help you assign dates to the columns.  
When the dialogue opens, you can click on the triangle and use the calendar to select 
the date.  Dates will be assigned to each column, excluding weekends.  You can bypass 
vacations, such as Christmas, by clicking on the first day of vacation and changing it to 
the return to school day.  PGGP only changes dates in columns including and to the 
right of the insertion point.

If dates have already been assigned, clicking the intersection of name and date 
will cause a dialogue to appear.  At this point you can click on the up and down arrows 
to assign demerits to the student/s in question.  

You will notice that there is a check box for marking a column a holiday.  Simply 
check the box and click the OK button.

Behavior Ideas

The Entry Screen is also available as in other subjects.  When you click on the 
Column Number Cell,  the double column Entry Screen appears.  Students can be 
assigned group demerits as in 
any other subject.  In addition to 
using group assignments, it is 
possible to select a group of 
students (it often takes two) for 
a demerit entry.  Holding the 
shift and clicking on multiple 
students causes the students to 
be selected for a “behavior 
incident”.  The next entry (click 
on any student's grade cell after 
letting up shift) will be assigned 
to this ad hoc group.

Variations on the above 
have been invented by teachers 
who like giving weekly grades 
(and who do not use the 
attendance module).  To make 
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Likewise, True Rubric 
calculates the grade for a 
subject to the lowest 
grade for any one of the 
standards.  This makes 
some parents and 
teachers nuts, but is a 
feature that your district 
may feel is valid. 

5 Rubrics can be set 
so that only the latest 
assessment of each 
standard  (by column) is 
used to calculate a grade.  
Mean or Latest will 
appear above the 
standards grades to 
remind you of which 
setting you are using.

The settings can be 
combined and PGGP will attempt to award standards grades according to your settings.  
Of course, some combinations make for interesting grades.
  You cannot set a weight of a Rubric Scored item.   This just did not seem to make sense 
when thinking about standards. 

Group Grade Entries

When working with cooperative learning groups, it is possible to enter grades 
by group.  Each subject allows separate group membership for each student.

Start a new assignment entry. (See Entering Assignments, above)  The middle of 
the screen contains the Group Entry Buttons.  

From top to bottom there is a Group Entry Box, a button for each group, a 
Group Button, an Unmark Button and a Done Button.

Putting an X in the Group Entry box will activate the buttons.
Clicking on the Group Button will change the screen to a Group Entry Screen.  

After clicking on the Group Button, start with the first student and assign each student a 
group number.  Selecting zero will cause a student to be omitted from any group.  
Either the number row or the 10 keypad can be used to assign group numbers.  Click 
on Done to return to Grade Entry.

To enter a Group Grade, click on a group button, e.g. Group 1.  All students in 
that group will be highlighted.  The next grade entered will be given to the group, and 
the highlighting will be removed.  At this point you may enter either a single grade for 
a student or another Group Grade by clicking on another Group Button.
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Printing Reports

Print Grade Book  (File Menu)

Selecting Print Grade Book prints all pages of the current grade book.  If all 
pages are not needed, select the page range needed in the standard print dialogue box 
that is placed on the screen.
  

When the grade books are printed, they are suitable for use as paper grade 
books.  Many users place printed pages in a binder and use this in place of the standard 
grade book.  Using this technique, you can reprint pages to "clean up" pencil 
corrections.

Mac: If you did not use Easy Setup, you must pull down the Settings Menu to 
Preferences and  Choose Printer Settings before printing any reports.  Follow the next 
sequence of dialogues to prepare PGGP to use your printer. 

Student Summary  (Reports Menu)

The student summary report prints a listing of the current student’s grades by 
assignment.   In addition, the weight of any assignment with a weight greater than one 
is indicated with an X and the weight in parentheses.  Late papers are indicated by 
showing the negative sign and the penalty. The report can be printed for one or all 
subjects for the selected student.  Begin dates and end dates may also be selected, 
making it possible to print only a certain range of assignments for a student.  
(Summaries can also be included in Letters.  See Preparing Letters)

All Grades  (Reports Menu)

(This is the one that makes it all worth it!) 

Selecting All Grades prints a mini-
report card.  Each student and all grades 
are placed in 2" X 4"  squares, ten per 
page.  The report includes GPA, At Risk 
notice, all subject grades... with either 
Effort Grades or Average as a Percentage, 
Behavior, Study Skills and Attendance information. 

These mini-reports can be attached to agenda books, homework folders, or a 
Record Sheet  (also found in the Reports Menu).  This is modeled after Avery Labels 
8253.   (All Grades can also be included in Letters.  See Preparing Letters)
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shift.  The toggle rules above will be kept in effect in the current entry cell and 
distributed to the group.  In other words, if that student already has a grade and that 
grade is not late, then all will get the late grade.  If the student's grade was late, and you 
attempt to give the group a late grade by holding down CTRL, the existing late will be 
undone and the group grade will not be marked late.

Quick Entry

The Quick Entry can be thought of as a Letter Grade Entry. All grades can be 
entered with the left hand, placing the pinky on the 1, ring finger on 2, etc. Each key 
press caused the letter grade and a predefined percentage (which can be set by the user 
in Settings) to be entered, e.g. pressing 4 will cause an A to we entered and 95% 
assigned to the A in the default setting. 

4= A (Press 4) 
3= B (Press 3) 
2= C (Press 2) 
1= D (Press 1) 
0= F (Press r) 
N/A (Press 5) 

Please note that this "Quick Entry" is very generic and cannot meet the needs of all.  
However, for "credit" type assignments, this can be very effective. The value of an "A" 
can be changed by selecting Quick Entry Setting In the Settings Menu. 
When entering grades, other symbols can be entered which may be helpful in 
identifying missing assignments. 

I= INC (Incomplete) 
A= ABS (Absent) 
N= N/A (Not applicable) 
B= Blank 

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears 
in the cell with the grade. If the grade was already marked Late, the "L" disappears and 
the grade is no longer late. 

Percentage Entry

The  Percentage Grade Entry allows you to type percentage grades.  Pressing 
ENTER tells the computer that entry is done and the cursor automatically moves to the 
next student.    If an error is made, the cursor can be moved up or down the list using 
arrow keys or the mouse.  PGGP normally limits any entry above 100% to 100% with 
an accompanying beep.  If you wish to give extra credit grades, you can set this Upper 
Limit to as high as 115% in Preference in the Settings Menu.

When entering grades, other symbols can be entered which may be helpful in 
identifying missing assignments. (See Quick Entry, above.)
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Letter  (Reports Menu)

Selecting  Letter allows letter printing.  If no 
letter has been selected, the standard Get File 
dialogue box is presented.  Select a letter you have 
prepared, or click on cancel.
Note:  To find out more about creating letters, see 
Preparing Letters.
 

 Next, a dialogue box will be presented that 
allows a great deal of flexibility in letter printing.  
The default setting prints all letters for students getting grades lower than C- in any 
subject.

In the upper left, 
there are four  buttons 
allowing you to choose 
which of the four 
language slots you want 
to work with.  (If during 
setup, you only entered 
one language, only one 
button will be activated.)  To add a letter you have prepared in another language, click 
the button and choose the letter.  Remember, to use the languages features, you must 
choose the number of languages to support, assign each student to one of the 
languages, and set up the 
languages in by using the 
Translation Tables in the 
Settings Menu.

In the middle left allows you 
to decide which letters are to 
be printed.   The up and down 
button changes the criteria in 
the box according the choices 
made in the lower left set of 
radio buttons.

The lower left of the box displays radio buttons in pairs, allowing the letter printing to 
be customized further. 

1) The first set of radio buttons changes the sort status from "grades lower than" 
to "grades equal to or better than".  It is important to understand the logic offered here.  
Lower than prints letters for any student having even one lower grade.  Equal to or 
better than prints letters for students having ALL grades equal to or better than the 
selected grade setting.
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current assignment.

The main Grade Screen remembers the following information: Its size, shape, 
font face, font size, and what subject was last viewed. 
 Please note that before you begin randomly placing grades in cells, create a New grade 
book by selecting New under the File Menu. 

Once grades have been entered the following areas can be accessed... 
The Grade Screen has a header across the top that always gives you the Date, 
Assignment Description, Weight, Points and if the assignment is a Rubric Assignment, 
the standard.  Clicking on any of these buttons in the header will take you back to the 
Assignment Screen where you can make changes. Please note that PGGP uses 
Relational Weighting and weight has nothing to do with “Categories”.  See Logic- p. 35 
In other words, Setting a weight to 40 does not make it 40% of the total grade.

The row under the header contains the column numbers, which can be thought 
of as assignment numbers. Clicking on the column number will return the user to the 
Entry Screen for that assignment. Note that the method of entry, number of points, 
group entry, etc. has been retained.  The Entry Screen is "magic" in the sense that unless 
the assignment has been entered by percentage, automatic calculations are made.  

The row under the column numbers show the weight of each assignment.  On 
the Macintosh, clicking the weight will allow you to change the weight.  Window and 
Mac users can change the weight by clicking the weight in the header. 

The student names are listed on the left.  Clicking on a student name will bring 
up the Student Database. 

In the main part of the grid, the current cell is highlighted. A highlighted cell can 
be changed any time. The current cell can be changed by clicking on the desired cell, 
using scroll bars, Enter (Return), tab or using the arrow keys.  It may seem odd that so 
little is said about the main part of the grid.  This is because PGGP uses other screens to 
enter information and grades.   

Entering Assignments

In the Assignment Menu, choosing any one of the five 
methods of grade entry (Quick Entry,  Percent, Number 
Wrong, Number Right, Rubric Scoring) will produce a dialogue 
that allows you to select the information for the assignment. 
 

Pressing Tab will move through 
the various settings.   Clicking on the 
bar above the date will invoke a pop-up 
calendar in the Mac version.   In the 
Windows version, double click the date, 
and double click the calendar date, too. 
(Try it.) 

The Grade Entry Screen allows 
you to see all the students as you enter 
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Student Data Base  (Reports Menu)

Selecting  Print Student Database places student information on a landscape 
printout.  This can be a handy list of student addresses, phone numbers, and birthdays.

Print Group List  (Reports Menu)

 Selecting  Print Group will print a sheet listing each Cooperative Learning Group 
and its members.  

Semester Average  (Reports Menu)

A Semester Average utility has been included, however, an accurate semester 
average can be tricky.  You must be sure the files contain information that can be 
averaged.  PGGP attempts to check for the following possible flaws and prints error 
codes.  

ERROR IN NAME: Indicates a mismatch in the student name.
"?" will appear in place of the first grade character if there are no grade entries in 

the first quarter.  "Error" will be printed in place of the Average.
"?" will appear in place of the second grade character if there are no grade entries 

in the second quarter.  "Error" will be printed in place of the Average. 
   The order of the students and subjects in the second file averaged will be the order in 
which the report is printed.
   Please note that the percentages on a regular printout indicate rounded numbers.  For 
the Semester Average, the real scores for each subject are averaged and then rounded 
for a semester average.

Web Upload (Reports Menu)

PGGP can upload grades to the Internet or a district Intranet.  PGGP uses Online 
Grades, a separate project to accomplish this.   Several major grade books use Online 
Grades.   A 45 day trial is offered and a six month trial is included with a new purchase.   
The proecess is quite simple one we have set up your database.   There are some 
requirements.to insure all works smoothly.  First, I will need:

Formal Name, e.g. Mr. Beckman
Your e-mail addresss.   (This is probably your “school” address reather than HotMail)
School Name
Phone Number- Optional  (Probably the school number)
School Town or District
School State
School or your class web page address (URL)
Your Name- e.g. George Beckman.

I use this information to set up your account.   When that is complete Online Grades 
sends an e-mail with your password and confirmation that all is ready.
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PGGP 5.0 allows the keeping of Behavior grades.  Beta Testers noticed that due 
to the nature of the demerit grading used in the behavior sections of PGGP (see 
Settings, Behavior Grades), the grading scale needed to be a sharper curve than the 
other effort grades.   The formula suggested is only a guideline.  Change these break 
points until you are comfortable with the final grades offered by PGGP.  The settings 
you are comfortable with may not become apparent until you have entered a number 
of columns of grades.  The effort symbols are shared with Academic Effort and Effort 
Only .

Step 5- Define INC/Late (Incomplete and Late)  

PGGP allows the percentage entry value for INC to be set.  If the “Activate” Box 
is checked, PGGP will use the percentage in grade calculations.  If INC is not checked 
then INC only affects the Academic Effort Grade.

PGGP also allows you to keep track of assignments turned in late.  If the 
“Activate” Box is checked, PGGP will subtract the percentage in the box from each 
assignment grade marked Late in the grade book.  (The actual grade received is always 
displayed in the cell, along with an L for late.  The penalty is subtracted when figuring 
grades.)

Step 6- Saving

The last step in Easy Setup is the standard save dialogue.  
One of the mysteries of the computer is knowing where a file is being saved.  

When you save a file for the first time, notice in which folder the file is going to be 
saved.  In both Mac and Windows the save dialogue box, above the list of files has a 
triangle (sometimes called a triangle thingy) on the right side of the bar.  The folder 
printed in this bar is the folder in which the file will be saved.  If you click the mouse 
and hold the button on the triangle thingy, you will see the entire hierarchy of folders 
that may contain your file.  This is VERY important after Importing a class list.  Unless 
you are an experienced user, it is suggested that you keep your grade files in the PGGP 
folder or your documents folder

If you work at school with a server, PGGP will save files at any location you 
choose (and have permission for), but again, be sure you know where you are saving 
your files.

Make sure you have given your new grade book a title that is descriptive 
enough to be recognized in months to come, e.g. Beckman Qt1 ‘99.  

New Quarter or New Grade Book

(If this is your first set of grades using PGGP, this section is not for you; go to 
Easy Setup.)  Make sure you come back next quarter.

Select New (File Menu)  while a grade book is open.  (You have student’s names and 
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you use the New menu to start a new grade period and new year.  If you start a file 
from scratch, PGGP will not remember the data.)  

The upload procedure is simple and fast.  

Choose Web Upload
Click Upload
PGGP will ask you where you want to save the upload file.  I always use the 
desktop, but it is up to you.
Your favorite Web Browser (Internet Explorere, Firefox, etc.) will appear 
showing you the Online Grades login screen.
Put in your name and password
On the left choose Submit File
Click Browse and find the upload file.  (as above I use the Desktop 
Click Submit.

Online Grades will tell you how many subject were found and report any problems.  
There should be no problems.  If there are, report them to gbeckman@pggp.com 
instantly.

Because Online Grades is “Online” there is help available there to assist you.   
You will find you can view grades.

If you view a class you can find the student passwords and copy them into a 
word processing document.  Devise some system to get theste to parents.

Export Grades(Reports Menu)
PGGP can export the “final grades” to a database.   One popular database is 

FileMaker but the exported file can be opened by excel or a database.

Report Card (Reports Menu)
PGGP can print report cards.  This is probably a school or district solution.   

Finally, Report Cards done right.  PGGP gives you the best of both worlds:  the power 
of the Web combined with a stand alone (on your computer) grade book.   PGGP, 
because it is an application on your computer is fast, fast, fast.  This allows you to enter 
grades at lightening speed.   When you want grades on the web for parents or report 
cards printed, PGGP makes one quick upload.  Parents can use PGGP's Online Grades 
view grades as the grade period progresses and you can print report cards in minutes 
when they are due.

Although some generic cards will be offered the cards can be designed in almost 
any form,  The cards are delivered in a pdf form, making it easy to save the cards and 
print them when cards are due.  Feel free to go to the PGGP website and look at 
samples there.  You may also write to George and to ask for a quote to design a card 
for your school or district.

Preparing Letters

The letter editor is found in the Reports Menu under Letter.  To write or edit a 
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the existing scale and plan the new scale carefully.   A single set of effort symbols is 
used.  The effort symbols are shared with Academic Effort, Effort Only and Behavior.  
You can only change this scale in the Academic Effort Formula Table. 

The Percentage of Assignments Complete Column calculates the number of 
assignments containing the grade INC or a Late.  If the percentages complete is at or 
above the percentage shown, the student will receive the effort grade to the right.  

The Cutoff Point By Percentage Column looks at the student’s current average in 
the subject.  If that average is at or above the percentage shown, the student will 
receive the effort grade to the right.  NOTE that this is an AND formula and a lower 
percentage in either column triggers a lower effort grade.  It is also important to know 
that the Effort Grade is calculated on Incompletes and Lates vs. Number of assignments 
completed by a student.  This means that a student absent five out of ten assignments 
and having one Incomplete has 80% of the assignments complete.  A student turning in 
all ten assignments and having one INC has 90% of the assignments complete.  

Effort Only Tab
Traditionally, many elementary grade cards report grades that are “Effort Only”.  

These are grades given in subjects such as PE and Art.  The grades are represented by 
effort symbols, such as E, S and N.  Remember, the effort symbols are shared with 
Academic Effort and Behavior .
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Settings

Number Of Students (Settings Menu)

 Choosing Number Of Students produces a dialogue that allows the number of 
students to be increased or decreased.  This affects printouts and the Grade Entry 
window.  

Letter Grade  (Settings Menu)

PGGP allows the percentage produced in Quick Entry to be changed.  Selecting a 
new percentage for an “A” causes all grades to reflect the change.  Selecting 97 for an 
“A” causes a “B” to be 87, a “C” to be 77, etc.  Remember, this is a generic method of 
entering grades and cannot be all things for all situations.

Formula Tables (Settings Menu)

 Academic Grade Formula allows the default grading scale to be altered .  These 
grade symbols will be given for subjects that are considered academic.  In most 
elementary schools these subjects have two reporting cells on the card, one for 
academic grades and one for effort grades.  The existing scale will be displayed.  Study 
the existing scale and plan the new scale carefully.  Letters, e.g. "B+" may be altered to 
any two characters such as O's and S's for each position.  Numbers should be between 1 
and 100. The third column allows you to apply a GPA value to each grade.  PGGP now 
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two ways to put in names: 
1)  Type the names
2)  Import the names

Typing the Names

Easy Setup brings you to a student data card.   Press Tab to move from entry to 
entry.  You are encouraged to fill in all the information.  At the least, fill in First and Last 
Name, Parent’s Name, and Gender.  If you selected more than one language when 
creating subjects, select the proper language for each student.  If you plan to upload 
grades to the Internet, you will also need a student ID.  This can be any number system 
you choose.

It is suggested that you move from student to student by clicking the “next” 
button rather than Done.  While this does not refresh the grade book in the 
background (for speed's sake), it will allow you to quickly enter student information.  
There is a pop-up menu which will be built once all the names are typed in or imported, 
making navigation from student to student easier.
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translation tables will need to be completed to effectively communicate with parents of 
students for whom you have assigned a language other than English.

Selecting Behavior Method presents two choices for entering behavior grades.  
PGGP normally uses two types of information that can be entered into a behavior 
column:

1)  Define criteria (See Behavior Definitions) and give students behavior demerits 
based on that criteria.  
2) Enter percentages in the cells.   

You cannot mix the type of information within a behavior column.  
Choose the method you would like for the column.  If you want PGGP to ask 

you which method you want to use each time a column is started, check the "Ask Each 
Time" box
. You may notice that in 
this example, I have set some 
fairly hefty demerits for 
possible problems.  You are free 
to set up the behavior 
definitions as you please.  The 
settings on the left are what you 
might use if using a card system 
of behavior.  You can click on 
any student for a column and 
enter a behavior incident. If you 
can see your card chart, click on 
the column for the date and 
hold shift.   Then click on the 
column to the right of each each student that has a yellow card showing.   The names 
will be highlighted   Let up shift and click any selected student to bring up the behavior 
entry box.  Click Yellow and Done.  All student selected were just given Yellow. Then 
move on to other colors. .

Clicking on Change Method in the status bar (top of the screen) will always 
bring up the Behavior Choice dialogue.  You can use this technique to change the way a 
column is entered or to change your mind about "Stop Asking".  Warning: Changing 
the way a column is entered resets the column's grades to 100.

Exclude From Average (Settings Menu)

 By choosing Exclude From Average, subjects can be eliminated from the GPA 
computation when the grades are printed.   An X beside a subject includes it in the GPA.   
Included subjects are also those figured into the Study Skills grade on the All Grades 
report. 
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Easy Setup

PGGP has an Easy Setup system. If you choose to use this Easy Setup, PGGP will 
establish a thread that will lead you. After following the Easy Setup thread, you will be 
ready to record grades. You can cancel the thread any time by clicking Cancel in any of 
the dialogue boxes. When possible the dialogue boxes contain default information, and 
but it is suggested that you review each 
carefully.

PGGP presents an opportunity to use Easy Setup 
an any time the user seems to be lost. The 
following instances will invoke the Easy Setup 
Screen:

1. Double Click PGGP and choose NEW in the 
File Menu.
2. Double Click PGGP and click anywhere on the grade grid.
3. While using PGGP for grade keeping or while looking at a Demo class, Choose New 
in the File Menu and click on "Start From Scratch" in the dialogue box.
Don't don’t start from scratch every quarter or every year.! The New menu will help 
with these situations so new quarters is quick and easy.

Step 1- The Creating Subjects dialogue Box

(Note that pressing Tab will move through the choices.)

Number of Subjects  Limit: 16
Choose the number of subjects to be graded.  

Enter Class Size                          Limit: 38
Enter the number CURRENTLY to be entered.  New students can be added later 

at the bottom.  (Students cannot be inserted unless they are replacing a student who 
moved, so if you have a combination class it is suggested that you split the class and 
leave a few blanks between classes.   If this is done, include the blanks in the number of 
students.   PGGP can sort the class alphabetically and will always allow you to return to 
the original order.  (See Settings)

Enter Number of Languages to be Supported Limit:  4
If you have students whose home language is a language other than English, 

enter the number of languages you plan to support. 

Enter Subject Names: 
Subjects should be put in the SAME ORDER as they occur on the report card.  

Subject names should be twelve letters or less to facilitate printing.  Example: SocialSt 
for Social Studies.  When using Macintosh, please don’t use a  slash ( / ) in a title.  This 
creates a Command Key option which may confuse PGGP.

PGGP has 5 separate grading formulas.   Academic subjects used in a traditional 
manner can keep both Academic (A and B) type grades and Effort (S and N)  If you do 
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Print Percent (vs Effort)  PGGP will print Academic Letter Grades and either a 
percentage or an effort grade.  .(Effort grade is a result of the Academic Effort Formula 
in the Formula Tables)

True Standards:  Checking True Standards will cause PGGP to give a total for the 
subject that is a result of the lowest standard . When checked, a student who is 
Proficient in Persuasion, Report and Summary but is Below Basic in Narrative then the 
writing grade would be shown as Below Basic.

Limit Standards to One:   PGGP can be set (best done before many assessments 
are entered) so that only one assessment of any single standard may be entered.  In this 
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Please read the first few 
chapters of this manual or access 
Help while running PGGP.   It 
may be helpful if you open the 
Sample Class file and  
experiment with the many 
features PGGP has to offer.

Automatic Update

PGGP willl check the Internet to see if there are upadates available.   If there is an 
update, a message will be displayed, telling you about the update and what the update 
adds or fixes.   If your Internet connection is slow, you may find a pause right after the 
startup (driveway) screen, 
while PGGP accesses the 
update information.  If you 
decide to update, PGGP will 
make every attempt to 
automate the process.   The 
download will start 
automatically.   PGGP will quit 
and the Installer will start.   
After the installer is done, 
PGGP will start again 
automatically.  You can find 
the exact build date of PGGP by selecting About PGGP.  On the Mac this is in the Blue 
Apple menu and on Windows it is in the Help Menu.

 Updating Your Files

Files from earlier version of PGGP can be upgraded to!5.0 files. PGGP 5.0 will open 
PGGP 4 files. A brief message may be displayed, telling you that the file will be updated. 
PGGP!5.0 for Mac will append the extension .pgp at the end of the file. This extension 
can be helpful in determining which file is 
which after you upgrade.
The new file is a completely different 
format... the exact format that PGGP!5.0 for 
Windows uses. This means that if the file is 
carried in to a Windows machine, it will 
open and save directly. However, earlier 
copies of PGGP will not be able to open the 
new files.  If you are moving to PGGP 5, 
make sure you don't have any older copies 
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To calculate averages PGGP multiplies the percentages times the weight, adds and then 
divides by the number of grades.  A weight of 2 is “added in to the mix” twice.  
Example: Sue has 4 grades.  

 Weight 1 1 2 1
 Sue 92 74 63 N/A

PGGP  adds the weights of the grades yielding a total of 4.  (1+1+2=4)  Note: the 
N/A is a null grade.  ABS and a blank are also null.  PGGP multiplies the grades times 
the weight and adds the products for a total of 292 (92+74+126).    PGGP then divides 
292 by 4, rounds to the nearest one, runs the number through the Formula and assigns 
the letter "C".

When computing an effort grade, PGGP looks at two things:  The percentage of 
Incompletes vs. the number of assignments the student turned in AND the student’s 
current Average in the subject.  NOTE that this is an AND function and a lower 
percentage in either column triggers a lower effort grade.  It is also important to know 
that the Effort Grade is calculated on Incompletes vs. Number of assignments 
completed by a student.  This means that a student who is marked absent (ABS) in five 
out of ten assignments and who has one Incomplete in the remaining 5 assignments,  
has 80% of the assignments complete.  A student turning in all ten assignments and 
having one INC has 90% of the assignments complete.  In other words, being in school 
and handing in your work counts. (Like I had to tell you that.)

When calculating a Standards-Based grade, no weights are used.  No standards 
are recorded until the first time a standard is used.   Then a new category is started to 
keep track of the standard.  

Standards Settings Logic

• Standards are averaged as traditional grades, but not rounded up.
• If True Standards is checked standards are averaged but the Subject Grade is the 

lowest of the standards for that subject
• If Use Latest is checked several entries of any one standard are not averaged.   

The last entry (by column, not by date) is used for each standard.grade and then 
all standards grades are averaged but not rounded for the subject grade.

Online Help

Online help can be accessed while using PGGP.  
On a Mac, PGGP Help can be found under the ? Menu.  The Help Window 

can be moved and sized, allowing you to read the Help File while actually working with 
PGGP.  Clicking back and forth between the Help File and the Grade Book can make 
this a very handy tool.

When running a Windows computer,.help is found in the Help Menu.  Pressing 
F1. will also activate specific help.  Preferences under the Settings Menu also allows 
Windows users to turn on Hints... those little yellow squares that pop up when the 
mouse hovers over a button or other control.
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PGGP was written by an elementary teacher.!!!The first copy was sold in 
September of 1987. The main purpose was to write a program that prepares grades for 
the elementary teacher. That was the objective, and so far users find this is exactly what 
the program does!!  PGGP is not like other grade books.   You might want to see the 
Logic PGGP uses, as described on page 35 and guarantee on page b, above.

First, remember, you are licensed to use PGGP at home and school for your 
student grades.!! (Your spouse can also use PGGP.... hope you have a long and happy 
marriage.)
p.s.! I retired from education in 2005 after 35 years in the business.!! I now have more 
time to work on PGGP and my wife and I are enjoying ourselves very much.

TECH SUPPORT:
You can contact me at via e-mail:
gbeckman@pggp.com
or
(559) 674-7848

U.S. Mail should be directed to:
George Beckman
22353 Ave. 18 3/4
Madera, CA 93637

Watch for Updates, Hints and News at:
http://www.pggp.com

ORDERS:
Orders: M-F, 8-5 CST
1-800-520-7768
Visa/Master Cards Accepted
District Purchase Orders Accepted
Fax 228-255-7086

Send Checks To:
STAZ Software- PGGP
320 St. Charles St.,
Bay St. Lewis, MS 39520

District Licenses are available and P.O.s are OK.

Check the site, www.pggp.com for pricing.

I am always happy to address any problems you may come across. If you think 
you have found a bug in PGGP, please contact me or go to the web site and look under  
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